
Modeliranje i animacija 3D objekta u alatu Autodesk
Maya

Rezo, Iva

Undergraduate thesis / Završni rad

2022

Degree Grantor / Ustanova koja je dodijelila akademski / stručni stupanj: University of 
Zagreb, Faculty of Organization and Informatics / Sveučilište u Zagrebu, Fakultet 
organizacije i informatike

Permanent link / Trajna poveznica: https://urn.nsk.hr/urn:nbn:hr:211:109117

Rights / Prava: Attribution-NonCommercial 3.0 Unported / Imenovanje-Nekomercijalno 3.0

Download date / Datum preuzimanja: 2024-07-30

Repository / Repozitorij:

Faculty of Organization and Informatics - Digital 
Repository

https://urn.nsk.hr/urn:nbn:hr:211:109117
http://creativecommons.org/licenses/by-nc/3.0/
http://creativecommons.org/licenses/by-nc/3.0/
https://repozitorij.foi.unizg.hr
https://repozitorij.foi.unizg.hr
https://zir.nsk.hr/islandora/object/foi:7288
https://repozitorij.unizg.hr/islandora/object/foi:7288
https://dabar.srce.hr/islandora/object/foi:7288


 

 

 SVEUČILIŠTE U ZAGREBU 

FAKULTET ORGANIZACIJE I INFORMATIKE 

V A R A Ž D I N 

 

 

 

Iva Rezo 

 

 

 

 

 

 

MODELIRANJE I ANIMACIJA 3D 

OBJEKTA U ALATU AUTODESK MAYA  

 

ZAVRŠNI RAD 

 

 

 

 

 

 

 

 

 

 

Varaždin, 2022. 



 

 

SVEUČILIŠTE U ZAGREBU 

FAKULTET ORGANIZACIJE I INFORMATIKE 

V A R A Ž D I N 

 

 

 

Iva Rezo 

Matični broj: 0066310652 

Studij: Poslovni sustavi 

 

 

MODELIRANJE I ANIMACIJA 3D OBJEKTA U ALATU AUTODESK 

MAYA 

  

ZAVRŠNI RAD 

 

                                                                

                                                                

Mentor: 

Doc. dr. sc. Zvonimir Sabati  

 

 

 

 

 

 

 

Varaždin, rujan 2022.



i 

 

Iva Rezo 

 

Izjava o izvornosti 

 

Izjavljujem da je moj završni/diplomski rad izvorni rezultat mojeg rada te da se u izradi istoga 

nisam koristio drugim izvorima osim onima koji su u njemu navedeni. Za izradu rada su 

korištene etički prikladne i prihvatljive metode i tehnike rada. 

 

                        Autor/Autorica potvrdio/potvrdila prihvaćanjem odredbi u sustavu FOI-radovi 

 

_______________________________________________________________________ 

 

 

 

  



ii 

 

Sažetak 

Rad objašnjava pojmove trodimenzionalnog modeliranja i animacije. Obuhvaća osvrt na 

poznate alate koji se mogu koristiti te detaljno opisuje alat koji će se koristiti u praktičnom 

dijelu. Prikazane su tehnike modeliranja te koraci animiranja osnovnih pokreta napravljenog 

modela. Praktični dio prikazuje proces izrade humanoidnog modela poligonalnom tehnikom 

modeliranja te način izrade animacija hoda i skoka. 

 

Ključne riječi:  Autodesk Maya; 3D modeliranje; Animacija; Rigging    
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1. Uvod 

Tema ovog rada je modeliranje i animacija 3D objekta. Prikazati će se cjelokupni proces izrade 

humanoidnog modela poligonalnom tehnikom te animacija istog. Proces izrade modela biti će 

prikazan pomoću alata Autodesk Maya. 

 

3D modeliranje glavni je element brojnih kreativnih karijera. Arhitekti i inženjeri koriste ga za 

strukturiranje i dizajn svog rada. Dizajneri i animatori igara koncentriraju se na 3D modeliranje 

kako bi ostvarili svoje ideje. Gotovo se svaki holivudski blockbuster služi 3D modeliranjem za 

specijalne efekte, smanjenje troškova i pojednostavljenje proizvodnje. Učenje 3D modeliranja 

može biti pravi izazov. Mnogi su programi komplicirani, a dobra načela modeliranja temelje se 

na temeljnim umjetničkim vještinama. [1] 

 

Ova tema izabrana je iz razloga što 3D modeliranje za računalne igre, filmsku industriju, dizajn 

interijera i slično postaje sve popularnije i traženije područje. Savladati dizajn i animaciju 

modela poprilično je složeno te zahtjeva dosta vremena kako bi se realizirao zadovoljavajući 

3D model. Oživljavanje ideja u vizualnom obliku čini 3D modeliranje i animiranje zanimljivim. 
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2. Trodimenzionalno modeliranje 

3D modeliranje je proces formiranja 3D prikaza određenog objekta ili površine uporabom 

rubova, vrhova i poligona u simuliranom 3D prostoru. Rezultati 3D modeliranja se mogu vidjeti 

u animacijama, filmovima i video igrama punim maštovitih bića i struktura. 3D modeliranje 

ostvaruje se ručno putem profesionalnog softvera za 3D proizvodnju koji dizajneru osigurava 

kreiranje i deformiranje poligonalnih površina ili skeniranjem objekata iz realnog svijeta u skup 

točaka podataka koji se primjenjuju za digitalno predstavljanje objekata. 3D modeliranje 

primjenjuje se u širem spektru područja, uključujući film, razvoj igara, inženjerstvo, 

komercijalno oglašavanje, arhitekturu i specijalne efekte. [2] 

 

 

Slika 1. Primjer 3D modela 

 

3D modeliranje se postiže uporabom poligona koji kreiraju objekt, drugim riječima, 

kombiniranjem geometrijskih tijela tako da dobiju oblik lika ili prostorni oblik. Ukoliko se 

ispravno namjesti veći broj čimbenika, mogu se dobiti vrlo stvarni modeli. Ovisno o ciljanom 

konačnom rezultatu i vremenskom periodu za izradu modela, dizajner bira metode i tehnike s 

kojima će modelirati. 

 

Modeliranje se dijeli na ručno gdje dizajner samostalno kreira svaki objekt te modeliranje koje 

primjenjuje skeniranje kako bi se napravio 3D model. 
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Neke od prednosti 3D modeliranja naspram 2D, osim animacije i izrade fizičkog modela, jest 

izrađivanje presjeka i pogleda, prepoznavanje grešaka te modeli imaju sve neophodne 

podatke za izradu, simulaciju i analizu. 

2.1. Poligonalno modeliranje 

 

Slika 2. Primjer poligonalnog 3D modela 

 

Poligonalno modeliranje bazira se na spajanju više vrhova (eng. vertex) pojedinog 3D prostora 

linijama te čine mrežu poligona (eng. polygon mesh).  „Tris“ označava najmanji poligon koji 

postoji. Danas gotovo svi 3D modeli napravljeni su kao teksturirani poligonalni modeli. U 

poligonalnom modeliranju upotrebljavaju se bazični poligoni kao što su valjak, kocka, stožac 

ili kugla. Ova vrsta modeliranja najprikladnija je za modele i za one koji zahtijevaju složeniju 

topologiju.  
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2.2. NURBS 

NURBS (eng. nonuniform rational B-spline) modeliranje je glatka mreža definirana nizom 

povezanih polinomskih krivulja. Glatka površina se pretvara u poligone tijekom renderiranja, 

tako da NURBS površine mogu sadržavati proizvoljan broj poligona. NURBS se može pretvoriti 

u poligone ili podijeljene plohe i korisni su za konstruiranje mnogih vrsta organskih 3D oblika 

zbog minimalne prirode njihovih krivulja. NURBS geometrija je prema zadanim postavkama 

glatka i ne treba je dalje dijeliti da bi postala glatka kao što to čini geometrija poligona. [3] 

Osim pri organskom modeliranju, NURBS modeliranje se obično primjenjuje i u automobilskoj 

industriji zbog ravnih ploha bez udubljenja. 

 

 

Slika 3. NURBS 3D modela 
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2.3. Subdivizijsko modeliranje 

Subdivizijsko modeliranje označava kombiniranje NURBS-a i poligona. Modeliranje većinom 

započinje kao poligonalno, a kasnije se upotrebljava matematika NURBS-a kako bi se zagladili 

grubi rubovi modela. Subdivizijske površine su definirane rekurzivno. Proces počinje 

dobivenim poligonalnim mrežama koje se usavršavaju te se ponovno primjenjuju kreirajući 

nova lica i vrhove na 3D modelu. Proces razdiobe se teoretski može obavljati u beskonačnost, 

ali u praksi je upotreba ovoga algoritma limitirana. [4] 

 

 

Slika 4. Subdivizijsko modeliranje 
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3. Programski alati za 3D modeliranje 

U današnje vrijeme postoji značajan broj alata za 3D modeliranje i animiranje, besplatnih i 

komercijalnih. Ovo poglavlje obuhvatiti će neke od najbitnijih i najkorištenijih programa za 3D 

računalnu grafiku.  

 

3.1. Blender  

Blender je besplatni program za 3D modeliranje. Podržava cijeli 3D paket – modeliranje, 

animacija opremanje, renderiranje simulacija, praćenje pokreta i sastavljanje, čak i stvaranje 

igrica i uređivanje videa. Napredni korisnici koriste Blenderov API za Python skriptiranje za 

prilagodbu aplikacije i pisanje specijaliziranih alata; često su uključeni u Blenderova buduća 

izdanja. Blender je idealan za pojedince i male studije koji imaju koristi od njegovog specifičnog 

paketa i responzivnog razvojnog procesa. Primjeri iz mnogih projekata temeljenih na Blenderu 

dostupni su u izlogu. Blender je višeplatformski i jednako dobro radi na Linux, Windows i 

Macintosh računalima. Njegovo sučelje koristi OpenGL za pružanje dosljednog iskustva. Kako 

bi se potvrdila određena kompatibilnost, popis podržanih platformi označava one koje redovito 

testira razvojni tim. [5] 

 

 

Slika 5. Blender logo 

 

3.2. ZBrush 

ZBrush postavlja industrijski standard za digitalno kiparstvo i slikanje. Njegove značajke 

omogućuju korištenje prilagodljivih kistova za oblikovanje, teksturu i bojanje virtualne gline u 
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okruženju u stvarnom vremenu koje pruža trenutne povratne informacije. Pri upotrebi ZBrush-

a korisnici su osnaženi istim alatima koje koriste filmski studiji, programeri igara, proizvođači 

igračaka/kolekcionarskih predmeta, dizajneri nakita, dizajneri automobila/zrakoplovstva, 

ilustratori, oglašivači, znanstvenici i drugi umjetnici diljem svijeta.  

 

Ukratko, ZBrush je umjetnički alat koji su stvorili umjetnici, za umjetnike. Omogućuje stvaranje 

modela i ilustracija ograničenih samo maštom, brzinom koja daje mogućnost istaknuti se u 

današnjoj brzoj industriji. [6] 

 

Slika 6. ZBrush logo 
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3.3. SketchUp 

 

SketchUp je softver za 3D renderiranje i modeliranje. Omogućuje jednostavno stvaranje 2D i 

3D modela. Softver ima velike modele temeljene na podacima i objekte spremne za 

preuzimanje. Može se koristiti i za modeliranje od nule ili uvesti 2D ili 3D datoteku i raditi na 

njoj. To je 3D softver koji preuzima 3D modele koje su izradili korisnici i postavlja ih u potpuno 

realizirana 3D okruženja ili slike. S programima za 3D renderiranje, grafički dizajneri i 

programeri medija mogu umetnuti različite objekte i likove, uvezene iz programa za 3D 

modeliranje, u grafički prikladno mjesto. Koristi se u različite svrhe kao što su kuće ili uredske 

zgrade, igre, dizajn proizvoda itd. [7] 

 

 

Slika 7. SketchUp logo 

 

3.4. Autodesk 3ds Max 

 

Autodesk 3ds Max je računalni grafički program za implementaciju 3D modela, animacija te 

digitalnih slika. To je jedan od najpoznatijih programa u industriji za računalnu grafiku te je 

popularan po robusnom skupu alata za 3D dizajnere. 3ds Max se najčešće koristi za 

modeliranje i animaciju likova, kao i za renderiranje fotorealističnih slika zgrada i raznih 

objekata. Kada se radi o modeliranju, 3ds Max je bez premca u brzini i jednostavnosti. Softver 

može podnijeti nekoliko faza animacijskog paketa uključujući predvizualizaciju, izgled, kamere, 

modeliranje, teksturiranje, postavljanje, animaciju, VFX, osvjetljenje i renderiranje. Kao jedan 

od najčešće korištenih 3D paketa na svijetu, 3ds Max nezaobilazan je dio mnogih 

profesionalnih studija i čini izniman dio njihove proizvodne linije za filmove i igre. [8] 
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Slika 8. Autodesk 3ds Max logo 
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4. Autodesk Maya 

Maya je program koji je stvorio Autodesk, a koristi se za modeliranje, animiranje i renderiranje 

3D scena. 3D scene stvorene uz pomoć Maye pojavljivale su se u filmovima, televiziji, 

reklamama, igrama, vizualizacijama proizvoda i na webu. Autodesk Maya omogućava 

korisnicima da stvaraju i animiraju vlastite 3D scene te ih prikažu kao fotografije ili animacije 

sekvence. Postoji nekoliko verzija Maye, a razlika između njih leži u značajkama koje su 

uključene u svaku. Na prvi pogled, Mayino sučelje može izgledati zbunjujuće, s gumbima i 

parametrima posvuda, ali zapravo su sve kontrole grupirane po logičnim skupovima. 

Upoznavanje s različitim skupovima kontrola čini sučelje jednostavnijim za rad.  

Maya se najčešće upotrebljava prilikom kreiranja specijalnih efekata u filmskoj industriji. Neki 

od poznatih filmova gdje su se koristili Autodesk programi su „Avatar“, „Planet majmuna: 

Postanak“, „Harry Potter i Darovi smrti 2.dio“. Osim u filmskoj industriji, Maya je korištena i za 

izradu popularnih video igrica, „Halo Wars 2“ i „Call of Duty: Black Ops III“.  

 

 

 

Slika 9. Autodesk Maya sučelje 

 

 

Trenutna najnovija verzija je Maya 2023 te će se praktični dio prikazati u istoj. Korisničko 

sučelje Autodesk Maye ima nekoliko skupina. Na samom vrhu sučelja dostupni su izbornici za 

opcije koje program sadrži. Na lijevoj strani nalaze se alati za uređivanje i pogledi skice, desno 

je uređivač atributa te se na dnu nalazi mjerilo i kontrole za animaciju, vrijeme i raspon trajanja.  
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Glavni izbornik uključuje opcije File, Edit, Create, Select, Modify, Display, Windows, Mesh, Edit 

Mesh, Mesh Tools, Mesh Display, Curves, Surfaces, Deform, UV, Generate, Cache, Arnold i 

Help. Sve aktivnosti i dizajniranja modela događaju se unutar glavnog prozora tj. prozora 

perspektive. Postoje tri koordinate (X,Y,Z). X označava širinu, Y visinu te Z duljinu. Također, 

primjenom alata može se rotirati, uvećati i mijenjati položaj objekta (Q-Select, W-Move, E-

Rotate, R-Scale). Za lakše kretnje Mayom upotrebljavaju se sve tipke miša. [9] 

4.1. Osnovni alati 

Za izrađivanje modela humanoidnog modela upotrebljava se poligonalno modeliranje. U ovom 

poglavlju objasniti će se osnovni poligonalni alati koji su se upotrebljavali. Neki od alata koji su 

se najviše koristili su Bevel, Extrude, Multi Cut i Connect. 

 

Alat Extrude poprilično je jednostavan modifikator. Omogućuje da se uzme otvoreni ili 

zatvoreni oblik i stvori 3D objekt s debljinom. Ovaj alat ima mogućnost istiskati i utiskati 

određene komponente poligona. Za početak, potrebno je označiti lice (eng. Face) poligona i 

kliknuti na Edit Mesh -> Extrude (Modeling Toolkit -> Extrude) ili skraćeno Ctrl+E. Pomoću ove 

funkcije gornjom se strelicom izvlače nova lica odabranog poligona (Slika 10.). Novo lice se 

po želji skalira, rotira, premješta, naginje ili dijeli.  

 

 

 

Slika 10. Extrude - 1 
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Slika 11. Extrude - 2 

 

 

 

Slika 12. Extrude - 3 

 

Alat Multi-Cut reže i umeće rubne petlje. Osigurava izvlačenje i brisanje rubova duž rezova, 

umetanje rubnih petlji i rezova s protokom rubova i podjela te uređivanje u načinu pregleda 

glatke mreže. Postiže se klikom na Mesh Tools -> Multi-Cut.  

 

 

Slika 13. Multi-Cut - 1 
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Slika 14. Multi-Cut - 2 

 

Alat Bevel proširuje svaki odabrani rub u novo lice, zaokružujući rubove poligonske mreže. 

Definirane rubove transformira u ravnu površinu tj. na području rubova stvaraju se lica. Stvara 

se klikom na Edit Mesh -> Bevel (Modeling Toolkit -> Bevel) ili Ctrl+B.  

 

 

Slika 15. Bevel – 1 

 

 

Slika 16. Bevel - 2 

 

Alat Connect omogućuje spajanje komponenti poligona umetanjem ruba između njih. Vrhovi 

su povezani izravno sa spojnim bridovima, dok su bridovi spojeni u svojoj središnjoj točki. Ovaj 

alat umetanjem rubova može dodati detalje jednostavnoj mreži. Kreira se klikom na Mesh 

Tools -> Connect (Modeling Toolkit -> Connect). 
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Slika 17. Connect 
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5. Izrada 3D modela 

Proces izrade humanoida je opsežan, ali u ovom poglavlju fokusiralo se na važnije koncepte 

neophodnih za jednostavnije razumijevanje. Detaljnije će se prikazati postupak modeliranja 

određenih dijelova. 

5.1. Modeliranje 

Za početak usredotočiti će se na glavu humanoida. Kreira se poligonalna kocka s dva odsjeka 

na svakoj osi. Odabire se Polygons -> Smooth za zaobljenje i dodavanje detalja. Odabirom 

istih lica (eng. face) izvršava se ekstrudiranje (eng. extrude) kako bi glava dobila više 

pojedinosti. Odabiru se vrhovi (eng. vertices) i redefinira oblik glave.  

 

 

Slika 18. Modeliranje glave 

 

 

Dalje se prelazi na modeliranje tijela. Modeliranje tijela počinje s poligonalnom kockom koja se 

nalazi lagano iznad tla. Dodaju se tri retka, svaki u subdivizijskoj širini i dubini (eng. 

Subdivisions Width/Depth) te četiri reda u subdivizijskoj visini (eng. Subdivisions Height). Ovo 

daje dovoljno materijala za modeliranje ruku i nogu. Odabiru se srednja dva lica na dnu modela 
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i klikne se na Edit Polygons -> Extrude Face. Ovo označava početak noge lika. Nastavlja se s 

ekstrudiranjem noge. Potrebno je kreirati dovoljno detalja oko koljena da se mogu glatko saviti.  

 

Ruke se stvaraju na isti način kao i noge. Dakle, odabiru se lica duž vrha strana tijela te se 

istaknu. Također, poželjno je navesti dovoljno pojedinosti za laktove lika kako bi se mogli 

ispravno deformirati. Oblikovanje tijela započinje tako da se prvo odaberu vrhovi duž vanjskih 

kutova i skaliraju se prema dolje. Time se zaokružuju kutovi modela. U pogledu sa strane (eng. 

side view), modelira se profil humanoida. Trbuh je potrebno popraviti i ispraviti leđa te nastaviti 

skulpturiranje tijela. Odabiru se lica na dnu nogu i lagano se ekstrudiraju kako bi se stvorila 

stopala. Nadalje, opisuje se modeliranje vrata. Potrebno je odabrati lica iznad ovratnika te ih 

izbrisati. Rubove oko otvora se ekstrudiraju. Smanjuju se i izravnavaju u okomitom smjeru tako 

da čine lijep oval koji će djelovati kao baza vrata. Kako bi se ovaj detalj uskladio s glavom, 

smanjiti će se otvor vrhova te ih urušiti. Kako bi vrat bio stvoren izabrati će se rubovi oko otvora 

za vrat i ekstrudirati će se ih dvaput. Tijelo je gotovo, dotjeravaju se grube točke i prerađuju po 

potrebi.  

 

Dalje će se nastaviti s modeliranjem šaka. Šaka počinje s kreiranjem jednostavne kutije koja 

je otprilike veličine dlana lika. Kutija bi trebala imati dva pododjeljka po širini i dubini. Ekstrudira 

se poligon koji predstavlja bazu palca nekoliko puta kako bi se stvorio palac. Odabiru se lica 

na prednjem dijelu šake, ekstrudiraju se te je potrebno pripaziti da je opcija Keep Faces On 

isključena. Ova opcija stvara prste. Osnovna topologija ruku je sada na mjestu. Vrhovi se 

obnavljaju kako bi dobili što prirodniji oblik. Lice se ekstrudira na bazi od šake par puta kako 

bi baza rukavice bila stvorena i oblikovana. Ruka je završena. Iako bi moglo izgledati kockasto, 

lijepo će se podijeliti. Može se testirati kako bi se prikazalo kako će se ruka podijeliti odabirom 

na Modify -> Convert -> Polygons to Subdiv. 
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Slika 19. Gotov model 
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5.2. Rigging 

Postavljanje (eng. rigging) se prvenstveno koristi u animaciji likova za stvaranje hijerarhijskih 

struktura zvanih kosturi. Kosturi se koriste kao okvir pomoću kojeg se deformira lik, kao i 

animira. Dobro postavljanje nadograđuje se na kostur kako bi se pružili dodatni alati koji 

animatoru olakšavaju posao dopuštajući brzo postavljanje i manipuliranje likom. Pri izgradnji 

kostura, uvijek je dobra ideja proučiti anatomiju lika koje namještamo. Postizanje anatomski 

ispravnog kostura rezultat deformacije učiniti će i anatomski ispravno. [10] 

 

Spojevi se izrađuju pomoću alata Spojnice (Skeleton -> Joint Tool), koji je također dostupan 

na kartici Animacija. Odabir alata omogućuje skiciranje zglobova. Da bi se određeni element 

dodao kosturu, potrebno je označiti zglob kostura, odabrati Joint Tool i započinje crtanje 

zglobova. Novi zglobovi postaju potomci visoko osjetljivog zgloba. Također, mogu se spojiti 

postojeći zglobovi odabirom na Skeleton -> Connect Joint. 

 

 

Slika 20. Plan rigging-a 

 

Na prethodnom primjeru (Slika 20. Plan rigging-a) vidi se da je stvaranje zglobova doista 

jednostavno. Modificiranje zglobova prikazano je na drugom koraku te se samo odabere i 

pomakne zglob kako bi se precizno pozicionirao. Na kraju, može se primijetiti pri crtanju 

kostura da zglobovi automatski formiraju hijerarhiju. 

 

Svaki zglob ima niz atributa za kontrolu ponašanja kada se s njime manipulira i animira. 

Osnovni atributi kontroliraju položaj i rotaciju zgloba, ali postoje i dodatni atributi. Dodatni 

atributi mogu pridonijeti prijevodu, rotaciji, skaliranju zglobova te određivanju orijentaciji u 

odnosu na druge. Također, neki atributi se koriste u inverznoj kinematici za određivanje ostatka 

položaja zgloba. Još jedna prednost je da zglobovi također mogu biti ograničeni u svom 

rasponu. Ograničenje pokreta u zglobu do prirodnih granica također zadržava pokrete lika 

prirodnim kada je animiran. Rezultat zgloba može se odrediti kao kost (eng. bone) ili kutija 
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(eng. box). Ograničenje stupnjeva slobode ograničava kako će se zglob okretati. Vrat ili spoj 

zgloba obično imaju slobodu od tri stupnja, a koljeno ili lakat ima samo jednu. Još je važno 

napomenuti da zglobovi mogu imati oznake kako bi se lakše identificirali. Naposlijetku, uočava 

se da ukočenost zgloba dolazi do izražaja kada se primjenjuje inverzna kinematika. Tvrđi 

zglobovi podliježu gibanju, tako da se manje okreću kada se izračunaju kada se izračunaju 

rješenja inverzne kinematike (IK). 

 

 

 

Slika 21. Rigging modela 
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6. Što je animacija? 

Program Autodesk Maya kreiran je za animiranje. Gotovo sve ima mogućnost animiranja. To 

uključuje boje, oblik objekta, teksture, jačinu svjetlost itd. Animacija se stvara namještanjem 

ključnih slika (eng. keyframes). 

 

Najvažniji alati koji se koriste za ostvarivanje animacije su uređivač vremena, uređivač opsega 

te uređivač grafikona. 

 

Uređivač vremena (eng. Time Editor) je opsežan alat za stvaranje i uređivanje animacija. 

Kombinira tijek rada za uređivanje animacije iz postojećih uređivača kako bi pružio intuitivan 

tijek rada temeljen na isječku za uređivanje nelinearne animacije koji omogućuje jednostavno 

kretanje između pogleda na razini isječka i detalja na razini ključa. Svaki objekt ili atribut u 

Mayi za koji se mogu postaviti ključni kadrovi može se unijeti u Time Editor kao isječak, koji se 

ima priliku uređivati na način koji nije destruktivan. Time Editor definira vremenske operacije 

(npr. brzinu, duljinu, vrijeme početka/završetka i tako dalje) animacije, tako da se može 

eksperimentirati s kombinacijama i varijacijama elemenata u svojoj sceni. Kada se stvori 

verzija animacije koja je optimalna u Time Editoru, može se sačuvati tako da se nova animacija 

može koristiti u Mayi. [9] 

 

Uređivač opsega (eng. Range Slider) nalazi se ispod vremenskog klizača i kontrolira raspon 

reprodukcije prikazan na vremenskom uređivaču. Glavne komponente ovog uređivača su 

vrijeme početka animacije, vrijeme početka reprodukcije, traka raspona, vrijeme završetka 

reprodukcije, vrijeme završetka animacije, ikona knjižne oznake, izbornik skupa znakova, 

izbornik sloja animacije. 

 

Uređivač grafikona (eng. Graph Editor) postavljen je kao grafički prikaz scenske animacije tako 

da se mogu stvarati, pregledavati i mijenjati krivulje animacije na različite načine. Na primjer, 

može se kontrolirati interpolacija između ključnih kadrova, ekstrapolacija krivulja i promijeniti 

vrijednost i vrijeme krivulja animacije mijenjanjem oblika krivulja animacije pomoću tangentnih 

ručki. Graph Editor uključuje alatnu traku, kadar i prikaz grafikona. Alatna traka uređivača 

grafikona nalazi se na vrhu i ima kontrole za brzi pristup za rad s tipkama i krivuljama u prikazu 

grafikona. Graph Editor Outliner na lijevoj strani je mjesto gdje se mogu pronaći čvorovi 

uređivača koji predstavljaju krivulje animacije. Sličan je Maya Outliner-u, ali ima neke 

specifične značajke uređivača. Prikaz grafikona na desnoj stani predstavlja mjesto za 

manipuliranje krivuljama i ključevima. [9] 
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Slojevi animacije omogućuju stvaranje i spajanje više razina animacije u sceni. Mogu se stvoriti 

slojevi za organiziranje nove animacije ključnih kadrova ili za ključne kadrove na vrhu 

postojeće animacije bez prepisivanja izvornih krivulja koje su dodijeljene. Slojevi animacije 

pojavljuju se naslagani u uređivaču slojeva animacije i ovisno o različitim postavkama, stapaju 

se kako bi stvorili animaciju koja se prikazuje u sceni.  

 

Na primjer, možemo učitati sekvencu animacije s likom koji hoda i skače kao što je prikazano 

u sljedećem poglavlju. Najprije je potrebno izraditi novi sloj animacije na vrhu kako bi se moglo 

eksperimentirati s izmjenama akcije skakanja. Treba se pogledati izvorna animacija kako bi se 

identificirala točka u kojoj se žele preuveličati pokreti lika na Y-osi, zatim postaviti tipke na 

novom sloju da se vidi kako promjena vrijednosti osi Y utječe na skok. Ukoliko modificirano 

kretanje skoka nije zadovoljavajuće, može se odabrati spajanje slojeva animacije. Ako izvorna 

animacija ostaje nepromijenjena, sloj se odbacuje. 
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6.1. Animacija skoka 

 

U ovom poglavlju obraditi će se pet glavnih koraka kako bi se stvorio elegantni skok 

humanoida. Koraci koji će se razraditi su ključne poze, mjerenje vremena tijela i stopala, koraci 

između, detalji i rad na spline-u te pomak ključa za prirodni izgled. 

 

Na samom početku, prije nego što se počne obrađivati animacija, potrebno je pripremiti 

humanoida tako da se promijeni ručna kontrola od fk do ik odabirom zelene strelice na obje 

ruke i promijeni vrijednost ispod ploče okvira kanala na 0. Odabirom krivulje tijela za pomicanje 

ruke se drže ikone i ne miču zajedno pa je potrebno uključiti opciju „Chest“ na 1. Ovdje se vidi 

kako ruka prati mjesto gdje ide tijelo. Nakon toga, prsti se savijaju tako da izgledaju prirodnije 

u opuštenom stanju. Stvara se nova polica i kreira se novi naziv te se moraju odabrati svi 

kontroleri. Zatim, dodaje se gumb za prečac na policu. Taj gumb značajno olakšava proces 

animacije. Nadalje, nastavlja se s prvim korakom u ključnim pozama i dobiva se ispravan 

vremenski raspored. Najprije mu je potrebno dodati normalnu stojeću pozu na prvom kadru, a 

nakon toga nastaviti u pozu čučnja i postaviti ključ na deseti kadar. Humanoida je zatim 

potrebno odvući u zrak i namjestiti željenu visinu te postaviti ključ na dvadeseti kadar. Kada se 

spustio na tlo tijelo se stabiliziralo na tridesetom kadru te se postavlja ključ. Na kraju, kreirana 

je odgovarajuća stojeća pozicija. Također, poželjno je pokrenuti animaciju da se sagleda kako 

radi u stvarnom vremenu.  

 

Nadalje, slijedi drugi korak. Potrebno je popraviti krivulju pri doskoku i skakanje tako da ima 

veći utjecaj na samog lika. Primjenjuje se koncept odskočne lopte gdje kontaktna točka mora 

biti oštra i prilagoditi krivulju kada napusti tlo i prije nego što sleti kako bi se osiguralo da 

istezanje ima potpun udarac. Noge je potrebno ispraviti prije nego što napušta tlo. Nakon što 

je krivulja prilagođena, ručke krivulje podešene te pokrenuta animacija, zapaženo je predugo 

vrijeme zaustavljanja u eteru prije nego što ponovno padne. Zbog toga je bilo potrebno izvršiti 

podešavanja kako bi izgledalo prirodnije. U ovoj fazi bilo je potrebno provjeriti dvanaesti kadar, 

u kojem je prikazano izravnanje noge. Također, mogu se koristiti opcije praćenja težine što 

omogućuje da se ručka duže povuče kako bi se mogao produžiti stup za noge na tlo. Kada je 

stigao do vrha, nožni kontroler ide dosta brzo kako bi dosegao mjesto stopala i kada ga udari, 

daje prikaz lomljivo odskočnog koljena koje ne izgleda optimalno. Iz tog razlog moguće je 

prilagoditi brzinu povlačenjem ručke tangentne težine. Nakon tog poteza, 28. ključ se namješta 

tako da noga dodiruje tlo i izravnava se prije nego što se stvarno stisne i udari o tlo. Zatim, 
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ponovno se prilagođava poza za čučanj tako da ima malo pomaka za obje noge i da izgleda 

prirodnije. 

 

U trećem koraku dodaju se koraci između skoka gdje se uočava da je potrebno kako bi se 

cjelokupna animacija napravila glatkije ili da ima više smisla. Npr. dodaje se kadar broj 12 i 28 

i namješta kuglasti zglob i kontrola okretanja prstiju tako da ima bolju pozu. Također, može se 

dodati i neku nesimetričnu pozu za ruke pri doskoku kako bi izgledalo prirodnije. 

 

Četvrti korak obilježava sve detalje. Potrebno je dodati detalje kralježnice, vrata, glave i fiksnu 

pozu iščekivanja prije skoka. Također, nakon uviđanja da animacija ide prebrzo, bilo je 

neophodno odabrati sve tipke na svim kontrolerima, a zatim ih povući malo dalje i proširiti od 

ukupnog broja od 40 kadrova na 50. Nakon povlačenja označavaju se sve tipke te desnom 

tipkom miša označavaju se te tipke tako da se zaokruži na cijele brojeve. Vrijeme zamahivanja 

rukama mora biti brzo, ali ne prebrzo. Potrebno je konstantno pokretati animaciju i provjeravati 

kako bi bilo umjereno. Također, treba se prilagoditi ukupna krivulja u nekim dijelovima gdje je 

ravna jer kao ravna izgleda malo kruto, a sa zakrivljenom obradom ruka izgleda bolje i 

prirodnije jer kretanje ne prestaje iznenada.  

 

Peti korak predstavlja sam kraj animacije skoka. Potrebno je samo nadoknaditi animaciju 

određenih kostiju sljedeći hijerarhijsku strukturu. U ovom slučaju odabirom na kralježnicu 3 

koja je blizu bokova i odabirom svih tipki pomaknutih za jedan kadar. Zbog toga kasni za jedan 

kadar, a zatim slijedi kralježnica, dva pomaka i dva kadra. Nakon toga ide kralježnica, jedan 

pomak i tri kadra, gdje se nalazi na prstima i poslije se odabire vrat i odmiče dva kadra. Na 

kraju, odabire se glava i pomiče unazad za tri kadra.  
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Slika 22. Skok pozicija 1 

 

 

 

Slika 23. Skok pozicija 2 
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6.2. Animacija hoda   

Ovo poglavlje pobliže će objasniti kako kreirati animaciju hoda. Na samom početku, vrlo je 

važno definirati 2D referencu ciklusa hodanja. Na priloženoj slici (Slika 24.) prikazana su tri 

kontakta. Kontakt (eng. Contact) znači da su obje noge na tlu. Poza u prolazu (eng. Pass 

Pose) je ključni kadar u kojem stražnja noga kreće prema tome da postane vodeća noga, s 

težinom koja je još uvijek na vodećoj nozi, noga je otprilike u ravnini s vodećom nogom u toj 

točki, a tijelo se počinje pomicati prema naprijed od vodeće noge. Postoji još i donja pozicija 

(eng. Down) i gornja pozicija (eng. Up). Osim toga, pobliže će se objasniti pokreti ruku. 

 

 

Slika 24. Plan animacije hoda 

 

Neke od jednostavnih i najkorištenijih kontrola su petna lopta (eng. heel ball) koja dopušta da 

rotaciju pete, kuglasti zglob (eng. ball joint), prst gore/dolje (eng. toe up/down). Za ovaj ciklus 

hoda važno je prebaciti kontrolu na FK, tj. kinematiku naprijed. Za ovaj slučaj potrebna je samo 

čista rotacija. Tako da će se koristiti samo rotacija koja je FK. Prsti i dlanovi oblikuju se kako 

bi izgledaju malo opuštenije. Sljedeće, potrebno je pomaknuti noge. Humanoid se spušta na 

tlo te se desna strana pomiče ispred, a lijeva iza. Ako se lijeva noga pomakne do maksimalne 

točke, petna lopta se mora prilagoditi tako da se malo savije. Desna noga se također 

prilagođava. Kadrovi se postavljaju na 1, 13 i 25. U kadru broj 13 obje noge su u različitim 

smjerovima tako da je važno promijeniti smjer.  

 

Nakon što je dovršena kontaktna poza, prelazi se na pozu u prolazu. Može se vidjeti da je u 

ovoj pozi jedna noga izravnana dok se druga pomjera unaprijed. Na broju sedam podiže se 

jedna noga te se formira broj četiri. Nakon što je noga podignuta važno je petnu loptu podesiti 

na 0. Kadar 19 i kadar 7 su identični, ali samo suprotna strana. Kopiraju se kukovi i pomjera 

naprijed do 90 stupnjeva kako bi se dobila približno ista vrijednost. Na kadru 19 zadnja noga 
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mora biti podignuta i rotirana te se jednako kopira u kadar četiri i označava petna lopta na 0. 

Noga koja dodiruje tlo također iznosi jednako. Dodaje se donja i gornja pozicija. Kadar deset 

predstavlja najvišu poziciju u ciklusu, tako da petna lopta četvrtog kadra mora biti na 0 te tijelo 

ide dolje. Jednako se kopira u kadar broj 16. Deseti kadar izjednačava se s dvadeset drugim, 

ali petna lopta iznosi 3.8. 

 

 

Slika 25. Animacija hoda 
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7. Slike gotovog modela 

 

Slika 26. Gotov model – 1 

 

 

Slika 27. Gotov model - 2 (skok) 
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Slika 28. Gotov model -3 (skok) 
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Slika 29. Gotov model - 4 (hod) 
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8. Zaključak 

3D modeliranje i 3D animacija na jedinstven način spajaju kreativni i tehnički rad. Danas se 

široko koristi u mnogobrojnim područjima i jedno su od najvažnijih vještina u poljima poput 

razvoja računalnih igrica, filmske industrije arhitekture te mnogih drugih. Tržište za kvalificirane 

3D dizajnere je široko i nastavlja rasti. Autodesk Maya savršena je za integrirano stvaranje 

trodimenzionalnih sredstava poput modeliranja, simulacija, animacija i renderiranja. 

Dizajnirana je za stvaranje realističnih likova i efekata u raznim industrijama. Za izradu 3D 

animacije treba se proći kroz faze modeliranja, „rigging-a“ i animacije, tj. 3D lika je potrebno 

opremiti za animaciju prije nego što to postane. Poželjno je modelirati sustavno i 

odgovarajućim redoslijedom kako bi se kreirala cijela slika modela. 

 

Tema završnog rada bila je modeliranje i animacija humanoidnog modela. Konačni rezultat 

animiranog modela za početnika u 3D svijetu je prikladan. Solidno su prikazani elementi 

humanoida. Ideja je ostvarena te je postignuta velika količina znanja. 
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11. Prilozi 

YouTube link za snimku animacija: 

https://www.youtube.com/watch?v=8TEwk4bZHlI 

 

 

https://www.youtube.com/watch?v=8TEwk4bZHlI

